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1 AC-DC Power Supply Specifications
Table 1. AC-DC Power Supply Specifications

PARAMETERS | CONDITIONS | MIN | TYP | MAX UNITS
Input Characteristics
Vin Input voltage 90 230 265 V AC
fac Input frequency 47 63 Hz
In Input current V\y = hom, lgyr = max 0.15 A RMS
Vin_uvio Input UVLO lour = Min to max 80 V AC
Vin_ov Input OV lour = Min to max 265
PF Power factor V\y = nom, 100% load 0.94
Output Characteristics
Vour Output voltage V\y = hom, loyr = nom 23.5 24 24.5 \
Reg_LN Line regulation Vv = min to max, loyr = nom 5%
Reg_LD Load regulation V\y = nom, lgyr = mMin to max 5%
Vour rippie | Output voltage ripple V\y = nom, gyt = max 115 Vep
lout Output current Vv = min to max 0 1.2 A
loce Output overcurrent V\y = hom 2.5 A
System Characteristics
fow Switching frequency 100 KHz
Eff_Peak Peak efficiency Vv = nom, lgyr = mMin to max >91%
Eff_FL Full load efficiency V\y = nom, gyt = max =90.8%
Top Operation temperature Vv = min to max, loyr = min to max -25 65 °C
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System Description

The use of brushless DC (BLDC) motors has been steadily increasing in applications where a wide range
of speed variation is required, because BLDC motors are highly efficient as compared to induction motors.
For very-low power applications, using low voltage motors offers several advantages, such as operation
over universal voltage input conditions, cost savings on motors and passives, compact printed circuit
board (PCB), and so forth. Moreover, highly integrated and protected low-voltage motor-driver integrated
circuits (ICs) make the motor easier to control and more efficient. However, the use of a low voltage motor
does require an efficient and low-cost AC-DC conversion stage. The TIDA-00652 design addresses this
application requirement in a simple and efficient manner. The PCB also integrates an efficient and feature-
rich motor controller stage, which enables customers to use this platform for applications such as ceiling
fans, exhaust fans, ventilation fans, oven fans, and other low-power BLDC drives used in home and
industrial appliances.

As Figure 1 shows, a buck power factor correction (PFC) power stage converts the 90- to 265-V,

50/60-Hz AC input to a regulated 24-V DC output. This design utilizes a UCC28180 PFC IC to control this
power stage. The 24-V DC generated by the power stage is used to power the three-phase, sensorless
BLDC motor controller DRV10983, which in turn drives the motor to control its speed. The DRV10983
controller also generates a 3.3-V supply, which powers the microcontroller (MCU). The MCU transmits the
speed reference to the DRV10983 controller in the form of a 1.5-KHz pulse-width modulation (PWM)
signal (producing a duty cycle proportional to the desired speed). This 1.5-KHz PWM signal is based on
the signal received from the infrared (IR) sensor, which in turn is activated by a general-purpose IR remote
control. Customizing the firmware of the MCU is easy for any given remote control data format.
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Figure 1. Top-Level Diagram Describing System Components
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3.1

3.1.1

Block Diagram
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Figure 2. TIDA-00652 Block Diagram

Highlighted Products

The following subsections detail the highlighted products used in this reference design, including the key
features for their selection. Refer to the respective product datasheet for complete details on any
highlighted device.

DRV10983 12- to 24-V, Three-Phase, Sensorless BLDC Motor Driver

The DRV10983 is a three-phase sensorless motor driver with integrated power MOSFETSs, which provide
drive current capability up to 2 A continuous. The device is specifically designed for low-noise, low
external component count, 12- to 24-V motor drive applications. The device is configurable through a
simple 12C interface to accommodate different motor parameters and spin-up profiles for different
customer applications.

A 180° sensorless control scheme provides continuous sinusoidal output voltages to the motor phases to
enable ultra-quiet motor operation by keeping the electrically induced torque ripple small.

The DRV10983 features extensive protection and fault detect mechanisms to ensure reliable operation.
Voltage surge protection prevents the input V.. capacitor from overcharging, which is typical during motor
deceleration. The device provides overcurrent protection without the requirement for an external current
sense resistor. Rotor-lock detect is available through several methods. These methods can be configured
with register settings to ensure reliable operation. The device provides additional protection for under
voltage lockout (UVLO) and for thermal shutdown.

The commutation control algorithm continuously measures the motor phase current and periodically
measures the V. supply voltage. The device uses this information for back electromotive force (BEMF)
estimation and the information is also provided through the I°C register interface for debug and diagnostic
use in the system, if desired.

A buck switching regulator efficiently steps down the supply voltage. The output of this regulator provides
power for the internal circuits and can also be used to provide power for an external circuit such as an
MCU. If providing power for an external circuit is not necessary (and to reduce system cost), configure the
buck switching regulator as a linear regulator by replacing the inductor with a resistor.

Texas Instruments (TI) designed the interfacing to the DRV10983 device to be flexible. In addition to the
I>C interface, the system can use the discrete FG pin, DIR pin, and SPEED pin. SPEED is the speed
command input pin. This pin controls the output voltage amplitude. DIR is the direction control input pin.
FG is the speed indicator output, which shows the frequency of the motor commutation.

EEPROM is integrated in the DRV10983 device as memory for the motor parameter and operation
settings. EEPROM data transfers to the register after power on and exit from sleep mode.

The DRV10983 device can also operate in register mode. If the system includes an MCU communicating
through the I°C interface, the device can dynamically update the motor parameter and operation settings
by writing to the registers. In this configuration, the EEPROM data is bypassed by the register settings.
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The DRV10983 has features that are highly useful for fan applications, such as:
* Programmable motor parameters for optimal working conditions with different motors
» Current limit, lock detection, and fault handling
* Thermal shutdown
» 180° sensorless control scheme
* Reliable starting of motor under different initial conditions
— Motor stationary
— Motor spinning in forward direction
— Motor spinning in reverse direction
» Commutation control angle advance
* Motor initialization
— Align
— Initial position detect (IPD)
» Acceleration settings

* Figure 3 and Figure 4 show the start-up and operation waveforms of the DRV10983 device driving a
fan load.

e T Y e

|0 LTI T [
voltage

i
Figure 3. DRV10983 Start-Up Waveform Figure 4. DRV10983 Operation Waveform
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3.1.2

3.1.3

UCC28180—PFC Controller

Although the primary use of a UCC28180 targets boost PFC applications, the user can easily adapt it to
control a variety of power topologies. This design highlights its usability to control a buck PFC topology.

The UCC28180 is a high-performance, compact eight-pin programmable frequency PFC controller. The
wide and programmable operating frequency of the controller provides flexibility to design at a high
frequency to optimize the components. A reduced current sense threshold enables the UCC28180 device
to utilize a 50% smaller shunt resistor, resulting in lower power dissipation. The UCC28180 also consists
of an integrated fast gate driver, with a drive of 2-A source current and —1.5-A sink current, which
eliminates the requirement for an external gate driver.

The UCC28180 device also has a complete set of system protection features that greatly improve
reliability and further simplify the design, as the following list shows:

» Cycle-by-cycle peak current limit

» Output overvoltage

* V¢ undervoltage lockout (UVLO) protection

» Transconductance amplifiers enable the bypassing of current loop by using a simple Zener circuit

MSP430G2231—16-Bit MCU

The TI MSP430™ family of ultralow-power microcontrollers consists of several devices featuring different
sets of peripherals targeted for various applications. The device features a powerful 16-bit reduced-
instruction-set-computing (RISC) central processing unit (CPU), 16-bit registers, and constant generators
that contribute to maximum code efficiency.

The MSP430G2x21/G2x31 series is an ultralow-power mixed-signal MCU with a built-in 16-bit timer and
ten input and output (I/0O) pins. The MCUs of the MSP430G2x31 family have a 10-bit A-D converter and
built-in communication capability using synchronous protocols, which consists of a serial peripheral
interface (SPI) or I°C.

Typical applications include low-cost sensor systems that capture analog signals, convert the signals to
digital values, and then process the data for display or for transmission to a host system. The following
features apply to the MSP430G2231.

» Low supply-voltage range: 1.8 Vto 3.6 V

» 16-bit RISC architecture, 62.5-ns instruction cycle time

» 16-Bit Timer_A with two capture/compare registers

» Universal serial interface (USI) supporting SPI and 1°C

e 10-bit, 200-ksps A-D converter with internal reference, sample-and-hold, and autoscan

» Serial onboard programming, no external programming voltage required, and programmable code
protection by security fuse

* On-chip emulation logic with Spy-Bi-Wire interface
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4 System Design Theory

41 Overview

The PFC stage converts the incoming rectified line voltage to a DC voltage on the output capacitor bank
C,. The power transfer occurs during instances when the line voltage is greater than the output voltage.
The resulting conduction angle is a function of both the incoming line and output voltages. In the current
TIDA-00652 design, the output voltage is set to 24-V DC. This output voltage is low enough to allow
conduction angles sufficient to achieve a power factor (PF) of at least 0.94 over a wide-input voltage range
from 90-V AC to 265-V AC. Other output voltage levels (below 26 V) can be set by altering the voltage
sensing network at the V¢gyse Pin (see Section 4.4). Figure 5 shows a basic buck PFC power stage. This
low-side switched buck stage has the same performance as the more commonly used high-side switched
buck converter. The incoming AC line is fed through a rectifier and filter stages (not fully shown in this
figure). The resulting unipolar voltage is then fed into the power stage. The MOSFET is switched at a
constant frequency of 100 KHz. The output voltage (V,) is developed across capacitor C,. The system is
operated in discontinuous conduction mode (DCM) to achieve good input current THD and power factor.
Figure 6 and Figure 7 show an abstract of the current and voltage waveforms at various locations in the
converter under DCM operation. For clarification purposes, note that the switching frequency in the figures
is deliberately shown to only be a few times higher than the line frequency (50 Hz to 60 Hz). However, in
practice, the switching frequency is usually selected to be many times higher than the line frequency.

CM 1/P filter
Choke inductor

_ip

90- to 265-V AC
47 o 63 Hz @ L)

28180 inductor

=S dex

Figure 5. Buck PFC Circuit
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Figure 6. Waveforms Showing Inductor Current, Rectified Input Voltage, and Output Voltages of Buck
Converter
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Figure 7. Waveform Showing Rectified Input Voltage and MOSFET Current

TIDUAS3A-November 2015—Revised May 2016 90- to 265-V AC, 91% Efficiency, >0.94 PF Buck-PFC Plus 24-V, 30-W 7
Submit Documentation Feedback Brushless DC Motor Drive Reference Design
Copyright © 2015-2016, Texas Instruments Incorporated


http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDUAS3A

13 TEXAS

INSTRUMENTS
System Design Theory www.ti.com
4.2 Buck Converter Inductor and Capacitor Calculation
The PFC inductor is designed for an inductance value that ensures DCM operation at the lowest input line
voltage, above which good power factor and THD are desirable (that is, > 90-V AC) right up to the full-
peak load. With an appropriate value of inductance, operation at higher loads, especially under low-line
conditions then results in CCM operation, especially towards the peak of the input voltage waveform.
Equation 1 calculates the inductance required for a design:
2
1 V,
=— x(min (Vm)— V, ) x (—OJ
2 x fgw * linpk ( ) min (V) @
For the present design, with a 24-V output and a minimum input voltage of 90 V, the period of non-
conduction can be neglected for all practical purposes, resulting in Equation 2:
| N PiN_avg X T
N_PK™ 25 min (V) @
Refer to the following seminar Power Factor Correction Using the Buck Topology—Efficiency Benefits and
Practical Design Considerations (SLUP264) for a detailed calculation of I, , [ 1].
Using Equation 3 and assuming an AC-DC conversion efficiency of 0.9, output power of 36 W, and
min (V,,) = 90 \2 V:
2
L = L x (9082 - 24) (i) 37 uH
2 x 100 x 10° x 0.41 902 @)
An inductor of 34 pH has been selected to guarantee operation in DCM, even under slight overload
conditions.
4.3 Calculation of Output Capacitance
Assuming that the percentage of non-conducting period is minimal, the required output capacitance can
be calculated as Equation 4 shows:
C. =~ 2 x Poap
0 ¥
nXVOXAVOXZXfUNE
where
« AV, = the peak-to-peak voltage ripple on the output (specification of < 2 V)
» fuxe = the input line frequency
* Pl = the output load power (all in Sl units) (4)
Insert the values into the preceding Equation 4 to obtain the following result in Equation 5:
2
Co ~ x 30 =39 mF
nx24x2x2x50 (5)
A capacitance of 4.5 mF has been selected to accommodate overload conditions and effects caused by
aging.
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4.4

4.5

Voltage Sensing Circuit

A high-voltage PNP transistor can be connected across the high-side bus voltage to provide a collector
current that varies in proportion to the bus voltage (see Figure 8). This current can be converted to a
sense voltage by feeding into a ground-referenced resistor. With this connection, the voltage sense is also
referenced to ground. This circuit is low cost and contains only a few more components than a typical
resistor divider. The PNP transistor must be rated for at least 500 V for high line-voltage operation;
however, these transistors are available in suitable, small surface-mount packages and leaded packages.
Equation 6 shows the relation between the sense voltage Vs se and the bus voltage, assuming that the
bus voltage is sufficient to forward bias the transistor and neglect its base current as compared to its
collector current.

Vor R, Vs
1+ x Rsense

Rs ©)

Vsense *

CM
Choke

o b

Rsense J/ VSEI‘ISE

Figure 8. Voltage Sensing Circuit

Refer to the following seminar (SLUP264) for a more detailed equation that includes the effect of the
transistor current gain. Adjusting the value of Rgyse Sets the V, voltage under closed-loop operation [ 1].

Control

The UCC28180 is a boost PFC IC by design; however, the flexibility offered by the IC makes it easily
adaptable to control a buck PFC topology. This adaptation is possible by bypassing the current loop by
placing a Zener-based constant voltage source at the Iy pin of the UCC28180 device. The user must
be careful to ensure that the potential of the I pin is kept above 3 V.

The voltage at the Vqyp pin is automatically adjusted by the closed-loop operation such that desired ramp
slope is achieved, which in turn produces the desired duty cycle to maintain the output voltage at the
desired level (24 V in this design).

From the datasheet of UCC28180, the ramp slope is provided by Equation 7:

fsw KHz > V
~ 22 x0.1223 x (V, - 0.5 —; for0.5<V, <46V
o5 KHzp>s< x (Vcomp ) COMP
V/us

aM_ s KHZ 0 1293 4 2 % (Vooup = 0.5) HS: for 0.5 < Vigoyp < 4.6 V
dVeoup 65 KHz Y @

=

The peak of the ramp voltage is given by Equation 8:

M
VRAMP_PEAK ~ f_
sw (8)

TIDUAS3A—-November 2015—-Revised May 2016 90- to 265-V AC, 91% Efficiency, >0.94 PF Buck-PFC Plus 24-V, 30-W 9
Submit Documentation Feedback Brushless DC Motor Drive Reference Design

Copyright © 2015-2016, Texas Instruments Incorporated


http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDUAS3A
http://www.ti.com/lit/pdf/SLUP264

13 TEXAS

INSTRUMENTS
System Design Theory www.ti.com
For an .o Voltage of 3.3 V, the duty cycle D can be calculated by using Equation 9:
D ~ Vramp_peak — 3-3
VRAMP_PEAK 9)

Also, assuming a 100% conduction angle, the operating duty cycle D can be calculated using Equation 10:

1 /PIN x4 xL
D~ —x [—mM
Vm Tsw (10)

When V,, = 90-V AC (assuming an efficiency of 0.9), the maximum expected value of duty cycle D can be
calculated using Equation 11:

(36) 4 x34%x10°°

1 0.9

~ x - 0.183
127.26 10 x 107°

(11

This result from Equation 11 corresponds to a Vgaue peax Of 4.038, which in turn corresponds to an M of
approximately 0.4038 V/us and a Ve 0f 1.86 V. Having established these corresponding values, the
user can place a Zener diode at the Voype Pin (Dzcome in Figure 9) to limit the voltage to 1.9 V (if required).
This Zener diode placement also limits the minimum input voltage at which the rated voltage output is
guaranteed.

The compensation network is almost the same as that used for a boost PFC circuit, except for the value of
the capacitor C-oyp,, Which must be adjusted so that the output voltage ripple has a minimal effect on the
duty cycle and sufficient time is allowed for a soft-start operation. The capacitor cannot be made too small
because during overload conditions the IC may connect a 4-kQ resistor in parallel to this capacitor (soft
overcurrent limit). A capacitor with a large enough value stabilizes the voltage at the Vqye pin, in spite of
the soft overcurrent limit, which occurs only in transients in the case of controlling a buck converter.

The user can add a high value resistor (between 300 kQ to 1 MQ) in parallel to the capacitor Ceoyp,, if
voltage droop characteristics with increase in load and decrease in input voltage is desired.

A small signal diode, Dy, is required to bias the V¢yse pin to a positive voltage during start-up, which is
required for the IC to begin operation.

VCC
| Vcowmp
COMP
Q ’%r Rcompi
Psr U C C28 1 80 Ccomp1 Ccomp2 (CI)Dpthgxgl)
VSENSE i i

Figure 9. Control Circuit Diagram
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5 Getting Started Hardware

1. Connect the single-phase AC power supply between pins 1 and 2 of connector J1 and turn on the
power supply switch. A multimeter connected between TP5 (+ve) and TP7 (—ve) must read
approximately 24-V DC. The user can tune the voltage between 10 V and 26 V by changing the
resistors R17 and R20. The higher the value of the equivalent sense resistor is (R17 in parallel to
R20), the lower the set point of the output voltage. The user can check the performance of the system
by connecting a resistive load between TP5 (+ve) and TP7(-ve), specified as < 35 W. The DRV10983
device solely accounts for short circuit and overload protection; therefore, do not perform any short
circuit or extreme overload tests on the 24-V DC output (between TP5 and TP7). Also, avoid start up
when resistive load is connected.

2. Connect a 24-V external DC power supply between TP4 (+ve) and TP6 (—ve) before programming the
DRV10983 device. The DRV10983 device can be programmed through the J4 connector. Refer to the
schematic and layout for pin assignments (located in the Tools & software section). Refer to the
DRV10983 webpage for more information regarding programming the DRV10983 device:
http://www.ti.com/product/drv10983.

3. The MSP430 controller is programmable through connector J2. The following Section 6 details
programming the MSP430G2231. Unlike the DRV10983 device, programming the MSP430 controller
does not require an external power supply. The power supply from the programmer can be used.

4. After programming the DRV10983 and MSP340G2231IPW14 devices, short TP5 to TP4 and TP7 to
TP6. Connect the U, V, and W outputs of the board to the motor U, V, and W phases respectively.
Connect and turn on the input power, which enables the fan to run. Press the appropriate button on the
remote control to change the fan speed. Ensure that the rated power consumption of the fan selected

is<35W.
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6 Getting Started Firmware
6.1 Motor Speed Control Firmware

The firmware for motor speed control consists of a remote that is based on the NEC IR transmission

protocol running at a carrier frequency of 38 KHz. The TIDA-00652 design utilizes a firmware developed

for the MSP430G2231 device to provide a three-step PWM duty cycle command to the DRV10983 device.

This firmware consists of the following features:

* A PWM duty cycle command is generated at 1.5 KHz.

» Each time the user presses the increment key, the duty cycle increases. When the user presses the
decrement key, the duty-cycle is reduced. The maximum duty cycle is 90% and the minimum duty
cycle is limited at 50%.

* By changing the key codes in the software, the firmware can be used with any IR remote that supports
the NEC IR transmission protocol.

6.2 Instruction to Change IR Remote Key Codes for Speed Control

Important downloads:

» The firmware for this design has been developed for MSP430G2231 using the TI Code Composer
Studio™ (CCS) IDE version 5.5.0. The user must ensure to have CCS version 5.5.0 or any other later
version installed as a first step. For details on downloading CCS, refer to
http://www.ti.com/tool/ccstudio-msp430.

« Download the TIDA-00652 firmware project files from the reference design webpage (TIDA-00652).

Hardware setup:

To obtain the remote key codes, do not apply the main AC power to the board. The onboard connector J2

provides a four-pin JTAG Spy-Bi-Wire interface. J2 has a pin for 3.3 V and any utility that provides SPI-

programming support J2 is capable of providing 3.3 V to onboard devices MSP430G2231 and IR senor

TSOP31338.

Steps to change remote key codes:

1. Launch the CCS software. Select Import Project from the menu toolbar. Browse to the file directory
containing the firmware in the subsequent pop-up window. Check the CCS project found and click the
Finish button (see Figure 10). The user can copy the project into the workspace, if desired.

. ¥ Import €€5 Eclipse Projects [
Welcome to Code COompq . ......cer oo —
'/ proj Highligh'l BI,EC:‘:""":'I?::J‘}EGIPszmztude [\ TEDA-D0386- Firmmware)\ TIDA
' 7 Loacs saaly) J ' —
" Examples : mmm;‘alm' - . Refreh
\/T" Import l:rn-ierr‘l
\\‘1 . 4
@ Support Finish C
\" Web Resources
Figure 10. Changing Remote Codes in Software—Step 1
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2. Build the project, by first left-clicking the project title and then clicking the Build button, as the following
Figure 11 shows. Close the Tl resource explorer window.

FrCCSE T =
File Edt View MNavigate Project Run Scripts Window Help
= ev- i v 1 (S CCoEan
(" Project Explorer [ = % 7 2 O (@ NResource Explorer 5 =
' TIDA-00386 IR Remote Code [Active - Debus

Packages: |Welcome »|[g®] Devices: |ai Tagies: |All oy

Wl <~ <2
Address: -
You can bring this page up at any time by selecting Welcome from the Help menu
= - Highlights
LSt Mew Project
. xplorer
« System Analyzer |
Yy + Trace Analyzer 3
w * ULP Advisor
Examples » GUI Composer
* Welcome to Grace 2
/ . Tutorial Videos
[~ Import Project
Getting Stagted with
CodgEomposeRstudio
0 Support r .
[ Problems &2 e
0 items
Description : Resource Path Location Type
. m »
O Licensed 1= TIDA-00236 IR Remate Code

Figure 11. Changing Remote Codes in Software—Step 2

3. Download the code by clicking the Debug button (bug icon). If the “ULP Advisor™” window appears,
click the Proceed button (see Figure 12). The user can choose to enable the option “Do not show this
message again” to avoid its appearance in future launches.

we CCS Edit - Code Composer Studia

sy ST
File Edit View Navigate Project R o |

ndow  Help

= sg., =

£ [E Cos e
() Project Explores 1 e =
1= TIDA-00386 IR Remote Code [Active - Debus
r =
¥ ULP Advisor™ o
The Uitra-Low-Power Advisor™ (ULP Advisor™) checks for ultra-low power best practices.
Vou have remarks in you praject, which you could use to improve power consumption in your praject.
Proceed with lsunch? Cancel to review advice in the Problems View, grouped under the Infos category.
Checking is enabled by default. Advice is grouped within the Problems view window under the Infos category.
To change default ULP Advisor™ settings, go to Project » Properties > Build > MSP43) Compiler > ULP Advisor™
For ULP Advisor™ rule details, visit hittp://www.ti.com/ulpadvisor,
For optien details, go to Help > Help Contents > M5P430 Optimizing C/C++ Compiler User Guide
Do not show this message again
(o
B Console i1 O 5 [B) B Gt B r = 0| problems 32 | 5 Advice =0
COT Build Console [TIDA-00386 IR Remote Code] 0 itens
. * || Description . Resource Path Location Type
** Build of configuraticn Debug for project TIDA-8R386 IR Remote Code ***
"CrtiVicosvs\wtils\\binl\gnake™ -k all
grake: Nothing to be done for “all’.
** Build Finished ***=
i B v
Licensed 12 TIDA-00336 IR Remote Code Launching TIDA-30386 1..e Code: (53%) &
Figure 12. Changing Remote Codes in Software—Step 3
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4. After successfully downloading the code, the following window in Figure 13 appears. Match the
console message and click the Resume button (the “play” arrow icon in the taskbar).

W% CCS Debug - TIDA-00386 IR Remote ne- Studia [E=mto8x)
File Edit View Project Tools Run Scripts Window Help
i s R -] LR e 9 7[Rz CCS Debug | B
%7 Debug £ > W 3w D e @ & % T T O 0 variables | 87 Expressions I Registers | 9 Breakpoints 11 &~ @ . k- =0
4 % TIDA-D0336 IR Remate Code [Code Composer Studic - Dwi:el:[r_:gun"e i } Hentity Name Condition Count Action
4 P TIMSP430 USBL/MSP430 -HW

= main() at main.c129 0xFAZS
= _c_int0_noext]) ot boot.c:183 (xFAF (the entry point was reached)

(&) main.c 12 | [E] main{ at DATIDA-DO336-Firmware TIDA-00386 IR Remote Code\Debug/../main.c129 Oxfa?8 -
}

a

}

127 void main(void)

%120 WDTCTL = WDTPW & WOTHOLD; /} Stop watchdog timer
1 Tnit_clock();

PIDIR |= BIT?;
PIOUT |= BIT?; P Output

PREN|=BIT3; Pu
PIOUT|=BITS;
PIDIR &= ~8IT3;
P1IE |= BIT3;
P1IES |= BIT3;
PLIFG B ~8IT3;

B Copsote ™
FIDA-D0CE6 IR Remote Code
M5P432: Loading complete. Code Size - Text: 908 bytes Data: 14 bytes.

| Licensed Writable Smast Insert 126:1

Figure 13. Changing Remote Codes in Software—Step 4

5. Insert a breakpoint by right-clicking at line 112 (right side of 112) and then selecting the Breakpoint
(Code Composer Studio) option from the cursor prompt (see Figure 14).

% CC5 Debug - TIDA-00386 1R Remots Cadalimaeis ~ Co0a Campasar Studia 5 oo e
File Edt View Project Tools Run Senpts  Windew Help

O i (@va- e i =1 (R Debug | 5 ¢
%5 Debug 22 . | 3 » % | € 7 = O 6= Variables | & Expressions | 1! Registers ® Breakpaints 2 L # - w | B~¥=0
4 K4 TIDA-00385 IR Remote Code [Code Composer Studio - Device Debugging] Tdentity Name Condition Count Action
% TI MSP430 USBL/MSP430 (Running)
1=
TACTL = TASSEL 2 + 10 @ + MC_1;
_ ':\m:d Process_Remote_Code(void)
if (FlagiSwitch_pressed) =
Flagh=~(Switch_pressed);
Last_Switch=Switch; an
12 FlasleiCtart ramote meocaeeis LiSat Bl
12f Breakpoint (Code Compaser Studic) v Breakpoint
Open Declaration B e O
Watchpoint
cue
Copy CtrrC
Paste. Ctrde W
=== Declantions v =
T?J:—Z References v =il B>r9~=0
MsPa3 Search Tet * Ecs Dota: 14 bytes.
R Line Ctl+R
Mo © Line
#Y Add Watch Expression...
Preferences...
© A Licensed Writable Senart Insert 12:1
Figure 14. Changing Remote Codes in Software—Step 5
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6. Point the remote toward the IR sensor and press the increment key. If the previous steps have been
performed correctly, the code halts at line 112. Move the cursor to the “Switch” variable on line 110

and a pop-up window appears as the following Figure 15 shows. Note the hex code as this is the code
for the increment key of the remote in use.

~+ CCS Debusg - TIDA-DO386 IR Remote Codefmaine - Code Compazer Studie T . B o e o || () ]
File Edit View Project Tools Run  Scipts  Window Help
il -2 @ - PR

& B~
4 Debug 32 B BB R i e & % T T O 0 Varables | &7 Expressions | Ml Registers |8 Breakpaints £3 [EE T RN
4 B9 TIDA-00335 IR Remote Code [Code Composer Studio - Device Debugging]
a @ TIMSP430 USBL/MSPA30 (Suspended - HW Breskpoint)
= Precess_Remote_Code] at main.cl12 (xF320
= main() at main.c:155 hFASC

= _c_intd0_noedt]) at boot.c183 0xFAFG (the entry point was reached)

Identity Name Condition Count Action
7| @ main.c, line 112 (Proc Breakpoint (1] Remain Haited

Ll main.e 22 | [£] main() at DATIDA-00385- Firmware\ TIDA-00335 IR Remote Code\Debug/../main.c129 xfa28

102 TACTL = TASSEL_Z + ID_B + MC_1;
200}
[T185 vaid Process_Remote_Code(void)

if (FlaghSwitch_pressed)

Flaga~(Switch_pressed);
Last_SwitcheSwitch;

i. 12 Flag|=(start| BPression Type Value
11 if (Last_Swi] e Switch unsigned long 16734375
Set_outp|
if (Set

}

else i (Las .
Default: 16734375 i

e wrr ] )
Decimal:16734375

2 Console & Octal: 077654247 SIELEEooE

Binary 11111118161100816180111 - E

TIDA-00386 IR Remote Code
MSP438: Loading complete. CHNE STYE = TEVYT UUE ByYEL DEYST T Eyeee:

% Licensed

Figure 15. Changing Remote Codes in Software—Step 6

7. Resume the code as outlined in Step 4. Point the remote toward the IR sensor and press the
decrement key. Repeat the process in Step 6.
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8. Repeat Step 6 and Step 7 two to three times and ensure that both key codes are the same every time.
Upon successful repetition, move the cursor to line 112 and disable the breakpoint by right-clicking
exactly at the breakpoint (left side of line 112) and selecting the Toggle Breakpoint option from the
pop-up window (see Figure 16). Terminate the debug launch by clicking the Stop button (red square
icon) next to the Resume button.

¥ CCS Dabug - TIDA-00386 IR Remote Code/main c - Code Composer Studia ———" - - - R ——————l A=A
File Edit View Project Tooks Run Scripts Window Help
=l e @8- ¢- 4 5 (A S Deug | 1
5 Debug 2 b M| B s s k| @ & € T 7 O - Varisbles |6 Expressions |12 Registers % Breskpoints 52 FEEEL Y ERVEEEE
« W TIDA-00336 IR Remate Code [Code Composer Studio - Device Debugging] Identity Pame Condition Count Action
a 5 TIMSPA30 USB1/MSPA30 (Suspended - HW Breskpoint) ) # mom linc 12 (Proc Breskpomt 0 Rernain Halted

= Process_Remote Codel) at main.c112 (nF920
= main{) at main.c:155 0FAGC
= _cnth0_noexitl) at boot.c183 0xFAFE (the entry point was reached)

() at DATIDA-00386-Firmware!\ TIDA-00386 IR Remaote Code\Debug/_/main.c:129 Oxfal

TACTL = TASSEL_Z + T0_@ + MC_L;
)

1105 void Process_Remote_Code(void)

if (Flag8Switch_pressed)

{
Flagle~(Switch_pressed);
Last_Switch=Smitch;

... Start Remote Process flag
»

Breskpoint (Code Composer Studic)
Togale Bresipeint CrrleShifts &
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Breskpoint Propesties...
Breskpoint Types » ]
Go'to Annctation el

Add Bockmark. k| E 1

Add Task...
dd Task. ata: 14 bytes.

<

Show Quick Diff CarleShifts Q.
¥ Show Line Numbers
Folding »

Preferences...

¥ Licensed witable Smartlnset | 112:76

Figure 16. Changing Remote Codes in Software—Step 8

9. Navigate to the main.c file under the main taskbar pane and change the key codes at line 64 and 65.
Re-flash the new code as Step 3 and Step 4 outline. The new code is now ready to use for speed
control with the remote (see Figure 17).

Edt View Nm

vigate Project

File

i 8 ccspenug [

i Bw v g i Sw v
125 Project Explorer £1 22 ° 0| G
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#define BTH 654
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s unsigned char Flag;

this is a big flag whic a
57 adefine Switch_pressed BITE
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59 wdefine start_bit_flag BIT2
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+ #deFine UP_Key ExBAFFSEAT
#define DOWN_Key @xRRAFFEEIT
“_"\—k

ivoid Init_clock(void)

BCSCTLZ = SELM_® + DIVM @ + DIVS_8;

if (CALBCI_1MMZ 1a BxFF)

DCOCTL = @xB@;

BCSCTLL = CALBCI_LMMI;

DCOCTL = CALDCO 1MHZ;
¥

BCSCTLL |= XT20FF + DIVA_®;

B Consete 7 B~ 9~ © B [ problems 51| ) Advice
Mo consoles to display at this time. 0 items :
Description Resource Path Location Type
) Licensed Wiritable Smat Insert 101:8
Figure 17. Changing Remote Codes in Software—Step 9
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7 Test Setup

Testing of the TIDA-00652 design was performed with a resistive load on the buck PFC converter.
Figure 18 shows the block diagram of the test setup with a resistive load.

Testing of the TIDA-00652 design was also performed with a fan load. Figure 19 shows the block diagram
of the test setup with a fan load.

Figure 18. Block Diagram of Test Setup With Resistive Load
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Figure 19. Block Diagram of Test Setup With Ceiling Fan Load
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8 Test Data
8.1 Results With Resistive Load Connected to Power Supply
Figure 20 shows the output power versus the efficiency graph of the AC-DC power supply. Figure 21
shows the output power versus the input current THD curves.
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Figure 20. Power Supply Efficiency versus Output Power Figure 21. Input Current THD versus Output Power
With Resistive Load
Figure 22 shows the output power versus the input power factor curves.
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Figure 22. Power Factor versus Output Power
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Figure 23 shows the output power versus the input power factor curves.
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8.2 Results With Fan Load
Figure 24 shows the input power versus the speed with the power supply driving the DRV10983 device,
which is subsequently driving a ceiling fan load. This ceiling fan is the same type of fan that the
predecessor design TIDA-00386 has used for testing. Because of the time varying nature of output power,
obtaining reliable efficiency data under a fan load is not considered possible. The user must rely on the
test results with a resistive load for AC-DC converter efficiency. Figure 25 shows the speed versus the
input current THD curves.
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Figure 24. Input Power versus Fan Speed Figure 25. Input Current THD versus Fan Speed
Figure 26 shows the speed versus the input power factor curves.
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Figure 26. Input Power Factor versus Speed
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Figure 27 and Figure 28 show the front and rear thermal images of the board working with the fan load at
an ambient of 22.5°C. These images are produced while operating at an input voltage of 230-V AC and
the fan running at 280 RPM.

—58.4

Figure 27. Thermal Image of Front View of Board While Running Fan Load at 280 RPM

—63.0

Figure 28. Thermal Image of Back View of Board While Running Fan Load at 280 RPM
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9 Design Files
9.1 Schematics
To download the Schematics for each board, see the design files at TIDA-00652.
9.2 Bill of Materials
To download the Bill of Materials (BOM) for each board, see the design files at TIDA-00652.
9.3 Layout Prints
To download the layout prints for each board, see the design files at TIDA-00652.
9.4 Altium Project
To download the Altium project files for each board, see the design files at TIDA-00652.
9.5 Gerber Files
To download the Gerber files for each board, see the design files at TIDA-00652.
9.6 Assembly Drawings
To download the assembly drawings for each board, see the design files at TIDA-00652.
10  Software Files
To download the software files for this reference design, see the link at TIDA-00652.
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its products (and of all Tl products used in or for such Designer’s products) with all applicable regulations, laws and other applicable
requirements. Designer represents that, with respect to its applications, it has all the necessary expertise to create and implement
safeguards that (1) anticipate dangerous consequences of failures, (2) monitor failures and their consequences, and (3) lessen the
likelihood of failures that might cause harm and take appropriate actions. Designer agrees that prior to using or distributing any systems
that include TI products, Designer will thoroughly test such systems and the functionality of such TI products as used in such systems.
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equipment includes, without limitation, all medical devices identified by the U.S. Food and Drug Administration as Class Il devices and
equivalent classifications outside the U.S.

Designers are authorized to use, copy and modify any individual TI reference design only in connection with the development of end
products that include the TI product(s) identified in that reference design. HOWEVER, NO OTHER LICENSE, EXPRESS OR IMPLIED, BY
ESTOPPEL OR OTHERWISE TO ANY OTHER TI INTELLECTUAL PROPERTY RIGHT, AND NO LICENSE TO ANY TECHNOLOGY OR
INTELLECTUAL PROPERTY RIGHT OF Tl OR ANY THIRD PARTY IS GRANTED HEREIN, including but not limited to any patent right,
copyright, mask work right, or other intellectual property right relating to any combination, machine, or process in which Tl products or
services are used. Information published by Tl regarding third-party products or services does not constitute a license to use such products
or services, or a warranty or endorsement thereof. Use of the reference design or other items described above may require a license from a
third party under the patents or other intellectual property of the third party, or a license from TI under the patents or other intellectual
property of TI.

TI REFERENCE DESIGNS AND OTHER ITEMS DESCRIBED ABOVE ARE PROVIDED “AS IS” AND WITH ALL FAULTS. TI DISCLAIMS
ALL OTHER WARRANTIES OR REPRESENTATIONS, EXPRESS OR IMPLIED, REGARDING THE REFERENCE DESIGNS OR USE OF
THE REFERENCE DESIGNS, INCLUDING BUT NOT LIMITED TO ACCURACY OR COMPLETENESS, TITLE, ANY EPIDEMIC FAILURE
WARRANTY AND ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND NON-
INFRINGEMENT OF ANY THIRD PARTY INTELLECTUAL PROPERTY RIGHTS.
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